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Installing the Software

For detailed installation instructions and any updates to this manual, please refer to the readme.txt file on the
Installation CD.

Running the program for the first time

When the program starts the first time, it will automatically display the communication options dialog for you
to specify the AIT device and its communications parameters.

This is very critical; make sure you select the right options for the communications port and contact memory
device used. The program will automatically select the highest baud rate for the chosen device. The view screen
option is used to trace the communications with the device.

“H - inventory. mdb M=l E3 I

File Edit “iew Toolz Help

—Inventory Record

PARTS DATA i
Part Mo: |55130-n?302-n49 Cage: (75265
i
Serial No: I H
e SRR Paths T Communications T Mizcellaneous
WIC: |15AF452 Paort Device Baud Rate Yiew Screen
=+ Coml * ButtonReader | | £ 9600 = Mone
¢ Com? " ButtonLazer £~ 15200 ¥ Mornteractive
‘e " ButtonLink oo | |nteractive
Caom3 = 57E00 Cancel |
" Comd 115200

Cancel |

Select the path tab and verify the default path: C:\Program Files\oomasnt
And default Database: inventory.mdb, after selecting your options, press Ok to save the selections.

L=

Paths T Communications T Mizcellaneous

Drefault Path: IE:"\F'ngram Filez oomasnt Brawse... |
Default Database: |inventu:ury.mu:|h Browse... |

Ok Cancel




Serial Number Tracking Operators Guide

This section of the manual identifies and describes each of the menu items available within the Serial Number
Tracking program. The Menu groups are: File, Edit, View, and Tools.

‘& - inventory. mdb I [=] E3 I
File Edit “iew Tools Help

— Inventary Record

PARTS DATA i
Fart No: |65130—D?302—D49 Cage: |?8285

Serial Mo |D1D?-D111E

WILIC: |1 RAF4R2 Pasition Code: |1

Save Hecord | Delete Record | Add Record Copy Record Wtite ChB | Read CMB Cancel

FARTS DATA RECORD
J (I (]

5 oo [

FILE

File/New Database

On the OOMASNT bar click File / New Database. The program allows the user to create a new database. The
default database is INVENTORY.MDB.

“E - C:\Program Files\oomasnt\depottest. mdb =10l x| |

File Edit “iew Tools Help
Mew D atab:

Open Databaze. .

Close Database PARTS DATA

Import Database.

Export Database. . 300-041 Cage: |?8285
Exxit
SENalHO: 414600035 I

wiLIC: |25|:1 540 Pasition Code: |1

E dit Record |SaveHecord IDeIeteHecordl Add Record I CDpyHecordI Write CHB I Fead CHB | Cancel I

PARTS DATA RECORD

|e1 0F |8‘I

=)
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LS




[~ Open as read-only

21 x| 1. Select the desired folder
Laak, ir: Iﬁ aomasnt location,
"1 Documents B ahars ] HMH7ES ) 2. Enter the database filename,
%93 %”‘F‘S %hmks 2] // 3. The filename extension must
146566 BALCK, inventory "
1) 162508 &) by @)Jef 7 // be .mdb (as shown).
1217164756 (& banyt el 4. Press Open
1211 15543 1] CMPTtest 7}
@25 @Depnt @
@55 @depottest @ /
121 65 2]
4| 3|
File name: j m
Files of type: IMS-AI:CES$[“.mdb] j Canicel |
4

Select the desired folder location enter the database filename. The filename extension, or type, must be MDB

and press Open.

=

@ C:AProgran FileshoomasntsSMT.mdb

This file does nat exist.

Create the file?

Press “Yes” and a new database will be created

File/Open Database.

On the OOMASNT menu bar, click File/Open Database. The program allows the user to open another

database. The default database name is inventory.mdb.

‘@ - inventory.mdb !EE '
File Edit “iew Tools Help
New Database..
DOpen Database...
LClose Databaze
Import Databaze. PARTS DATA
Export Database. ..
Exit [i0-07302-049 Cage: I?BZBB
Serial No: |D1D?—D1116
WL |1 LAF4R? Position Code: |1
Edit Fecord Save Record Add Record Copy Record Write ChWBE I Read CME Cancel
o FA&RTS DATA RECORD
st J |||l
oy |1 OF |4?




'EI - inventory. mdb M=E3
File Edit “iew Tools Help

- Imvente B - (> |
ook [ s =& @ o
@ temnplate.mdb
= @inventor}l.mdb ’3|?8286
Sel

3:'1—

File name: I Open

Files of type: IMS—ACCESS(*.mdb) j Cancel |

[~ Open as read-only

Read ChB Cancel

v

Selected the desired file or folder and click “Open”.

File/Export Database

On the OOMASNT menu bar, click File / Export Database. The program allows the user to export the data to a
text file.

'EI - inventory.mdb HEB
File Edit Yiew Toolz Help

Mew Databaze..

Open Databasze. ..
LCloze Database

Import D atabaze. PARTS DATA

Export Database. ..

Eait p0-07302-043 Cage:[75255

Serial No: |D1 07-01116

WUC: |15AF452 Position Code:|1

Edit Record Save Becord [Lele corgl]  Add Record Copy RBecord rite CWB Fead CMB Cancel

FPARTS DATA RECORD

e [

(|




If the file you want is in a folder, double-click the folder. Double-click the file you want to use or type a new
file name. This allows user the option to save text file to hard drive or to a 3% floppy.

'El - inventory. mdb M=k I
File Edit “iew Tools Help
SUELH S elect Export Filename HE
Svein [ My Dooumans EEEE
DrxDiag. ket Seriglized|tems. bkt [ filelib
N H efaddr. txt [ nalesery [Z My Pictures B I?gggg
_____ T9kut [ genmanual
_____ Document. bt [ My Music
Sel |Z] Dawnload bt (0 milstd130
_____ SCADC bt [ MySetups
Wisio Wweb Site Map.txt [ presentations
' |51 0l Excel Documents [Z1 Messenger Service Received Files = I]
KN | 0|
File name: Save I
Edit Pead CME | Cancel

Save as type: Itab—delimited tEd™ tet) j Cancel |

[T Openasread-only

Export will generate a window telling where the file was exported

x

@ [atabase exported ta file C:\FProgram Fileshoomaznthtest] bt

File/Import Database

On the OOMASNT menu bar, click File / Import Database. The program allows the user to import data from an
exported text file. The text file will be imported into a new or previously created database.

g - inventory.mdb _[O] %]
File Edit “iew Tools Help

Mew Databaze...

Open Databaze...
E|DSE [Databaze PARTS DA TA
Impart D atabaze.
Export Database. .. Cage: |28Ei?'8
E xit
SEMaEr 371
WLIC: |‘|5I3?EIDD Position Code: |1

Save Hecord | Delete Record | Add Record Copy Record | wirite CHE | Read CHEB | Cancel |

PARTS DATA RECORD
ENLAE ] th— T




Locate the text file, and click the Save button. Assuming the data is valid, the program will add the data from
the text file to the currently opened database.

& - inventory. mdb o =] 4|
File Edit “iew Toolz Help
— Inventony Record
Select Import Filename K E3
Save n: | ‘= oomasnt =l | @I gl
Part Mo e DOETE
Serial Mo
wilIC: 1
|_EditRecord Fead CMB | Cancel |
S File name: Iexport,txt Save I
Save ag type: I[MS-Access Files) . mdb j Cancel |
A [ Dpen as read-only
=) Z

Edit

Edit/Cut, Copy, Paste
S (1]

Filz | Edit Yiew Tools Help

—lr

= Copy Chil+C
Paste Chil+y
: PARTS DATA
Dptions...
Fart MNo: |65130—D?302—D49 Cage: |?8288
Serial Na: |D1D?—D1116
WIIC: |1 EAF4R2 Position Code: |1
Edit Fecord | Save Record Add Record Copy Record Yrite ChB | Fead ChB Cancel

PARTS DATA RECORD
|| I | ]| ]
|1 OF |4?

CUT

Press the Edit Record button. Highlight the information that will be edited. On the Edit menu, click Cut.
Click the place where you want to put the information in the document. On the Edit menu, click Paste.
The information is removed from the original document and is placed in its new location.

COoPY

Press the Edit Record button. Highlight the information that will be edited. On the Edit menu, click Copy.
Click the place where you want to put the information in the document. On the Edit menu, click Paste.
The information is copied from the original document and is placed in its new location.



Edit/Options
The Edit/Options menu item allows you to customize certain parameters that affect the program operation.

'EI - inventory. mdb H=] E3 I
File Edit Yiew Tools Help

— Imverntary Record
PARTS DATA ¢
Part o 51 30-07302-049 Cage:[raoes
R
Serial Ma: I _ \
B Paths T Communications T Mizcelansouz
WLIC: |15AF452 Part Device——— Baud Rate View Screen
i+ Caml ¥ ButtonFeader " 9600 " Mone
= Com2 " ButtonLaser 13200 £+ Maon-nteractive
' {~ ButtonLink & 0 £ [nteractive
Com3 ¢~ 57600 Cancel |
" Comd ' 115200
Cancel | :

The Communications tab is used to setup the communications parameters for the contact memory device that
will be used. This tab allows you to switch devices at any time. Select the communications port to which the
contact memory reader device is attached. Select the type of device that will be attached. This will
automatically allow the highest available baud rate to be selected. The View screen option toggles on and off
the display of the communication session between the PC and the reader device.

JRI=TEY

Pathsi 1 Communicatiorns 1 Mizcellaneous

Crefault Path: | C:AProgram Fileshoomasnt Browse... |
Default Databaze: |invent|:nr_l,l.ml:||:u Browsze. .. |

Ok Caricel

The Path tab provides selection for a default path and a default database file
Choose the top browse button to select a default directory
Choose the lower browse button to select a default database.



View

View/Form

& - C:\Program Files\comasntASNT.mdb e =10} x|

File: Edit | Wigwe Toolz Help

v Fom |

List
IR PARTS DATA
Part Na: | Cage: |_'

Serial Mo |

LI | Pozition Code: |

Edit Pecord | Sove Becoid | Delete Pecord | AddPecord | CoppPecord | white CME | PeadCME | Cancel |

|F <l PARTS DATA RECORD

[l °°

| The
View/form Menu item switches the display from list mode to form mode. Form mode is also the only view that
allows data to be added, edited, or deleted.

Buttons

Add Record

Click on the Add Record button. This allows the user to enter a new record. Press the Save Record button after
the data has been entered.

Edit Record

Click on the Edit Record button. This will open the form in edit mode, allowing user to edit existing records.
Press the Save Record button after the data has been edited.

Copy Record

Click on the Copy Record button. This will create a copy of the current record with the exception of the serial
number. The record will automatically be in the edit mode allowing the allowing user to edit the serial number.

Write CMB

Click on the Write CMB button. This allows you to write the current record to a contact memory button. The
current device will be used to write to the CMB.

Read CMB

Click on the Read CMB button. This allows you to read a single contact memory button. It will automatically
store that data in the database. The current device will be used to read the CMB.



Delete Record
Click on the Delete Record button. This will allow the user to delete existing records. The program will ask to

confirm the delete action. “NOTE” Once a record is deleted, it’s permanently erased from the database.

& - inventory. mdb = [=] E3
File Edit “iew Toolz Help
— Inwentory Recaord
PARTS DATA
PartNes5130-07302-049 Cage: I?SQSB
Delete Record
Serial Mo ID1 07-01116 @ Al the data will be deleted. Do you want to delete?
WIIC: |1 LAF452 Mo | ition Code: |1

Edit Becard | Save Becord | Delete Becord | Add Record Copy Record ‘Wite CMB | Read ChB Cancel

— FPARTS DATA RECORD —

TN AR (R | 7Y

@) [ | OF Jo ¥

View/List
The View/List menu item will display the data in a list, or spreadsheet, fashion.
“F - inventory. mdb _ O] %]
File  Edit | Wiew Tools Help
~Invent g Eom I
Parts Data »
PARTS DATA
Bat e 651 30-07302-043 Cage: I?BEBB
Serial Mo |D1D?—D111B
WLIC: |15AF452 Fosition CDde:I]
Edit Record I Siawve Fecord |De|ete Record | Add Record Copy Fecord Srite CMEB I Read CMBE Cancel




“E - inventory. mdb

File Edit “iew Toolz Help

=] E3

— Inwventory List
dhid ineid FarMo Cage SerialNo Wiuc —
! D107-01116
a 0 65130-07332-042 B247-00703 P,
a I B5130-07332-042 78286 B247-00543 / 164F4
a 0 65130-07332-042 76286 BEB?—DW 16AF4
a 0 65170-11250-046 78286 1 194 16474
a 0 65170-11250-046 76286 /%98 16474
a 0 65170-11250-046 78286 / C100-07200 16474
a i 65170-11250-046 ?8286/ C100-01204 16474
a 0 B5170-11250-046 M 0100-00033 16474
a i BE5170-11250-046 G286 D100-00036 16474 &
| - i
*dit Recurdl ﬂite selected Records | Fiead all recards |

Use the scroll bar to view data to the left or right of the current view.

Edit Record

Takes you to the form screen for updating and changing record data.

Write Selected Record
Transfers selected records to the ButtonReader/DownLoader

Read all Records
Downloads all data from the Button/Reader. (This feature is helpful when building a new database after the

reader is returned to the DownLoader).

Selecting more than one record:

" - inventory.mdb
File  Edit “iew Tools Help

FARTS DATA RECORD

|1 aF

[

[ D[]

—Inventony List

B

_1_

column.

0 0 65130-07332-042 78286 B287-00703
6513007332042 78286 B247-008
65130-07332.0 01016 [15AF4
045 78286 C100-01194 15474
6517011250046 78286 C10001198 15474
65170-11250-046 78286 C100-01200 16ATd
65170-11250-046 78286 C100-01204 16A74
65170-11250-046 78286 D100-00033 16A74
65170-11250-046 78286 D100-00036 15ATd &
O

“rite Selected Records |

Read all records I

10

3. Continue

records.

Select desire record in the far left

Holding the control (Ctrl) key, click
left mouse button to select record.
holding Ctrl key and click
left mouse button to select other




Tools

Tools/Read Part Id from Contact Memory

The Tools/Read Part Id from Contact Memory menu item allows you to read a single contact memory button. It
will automatically store that data in the database. The current device will be used to read the CMB.

'EI - inventory. mdb [_ (O] x|
File Edit View | Tools Help
| i = BRead Part |d From Contact Memorny
w ‘wirite Part |d To Contact Memory
Inventary Reconciliation 'Wizard...
Fieportsz... PARTS DATA
ButtonFieader Utilities 3
Part M | Cage:
Serial MNo: |
WG | Paosition Code:
Edit Fecord | | Delete Fecord | Add Record Copy Record ‘Write CMB | Fead ChB Cancel
> | | PARTS DATA RECORD
1 OF 47

Tools/Write Part Id To Contact Memory

The Tools/ Write Part Id to Contact Memory menu item allows you to write the current record to a contact

memory button. The current device will be used to write to the CMB.

“H - inventorp.mdb O] =]
File Edit “iew | Toals Help
| t = FRead Part Id From Contact Memony
w Wiite Part |d To Contact Memary
Inventory B econciliation wizard...
Reports... .PAR?S DﬂTA f
ButtonReader Utilities 3 r
Fart M- | Cage:
Serial No: |
WLIC: | Fuosition Code:
Edit Record | | Delete Record | Add Record Copy Record ‘Write ChB | Fead CHMB Cancel
> || PARTS DATA RECORD
1 OF |47
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Tools/Inventory Reconciliation Wizard

The Inventory Reconciliation wizard is a tool designed to quickly compare collected serial number data to the
database serial number data. It prompts the user for the required inputs and produces three lists: a matched item
list, an unmatched item list, and a missing item list.

&l - inventory.mdb M= E3 I
Eile  Edit Miew | Tools Help

Bead Part |d From Contact Memary

— lrventory: Fie

wiite Part Id To Contact kMemony

Inventory Feconciliatio ard...

Feports. .. PAREDAM :

ButtonReader Utilities 3 I
Fart Mo Joo o007 Soc0T Cage: I?BEBE

Serial No: |D1D?‘—D1116

WhILIC: |1 A FA62 Fasitian Code:|1

Edit Fecard | Sawve Record |De|ete Recordl Add Record Copw Record wy'rite ChB | Fead ChEB Cancel

PARTS DATA RECORD

flb‘ql‘bll

The Wizard starts with a welcome screen. Press the Next button to continue.

i - inventory.mdb =] E3
File Edit “iew Toolz Help

—Inventary Record

# Inventory Reconciliation Wizard E

—Welcome

Farthe: 651 “Welcome ta the Inventary Reconciliation Wizard. This wizard will guide yau through
the steps required to collect componentinventory data, import the data, and

compare it with the inventory database.
seral Mo D¢

WWJC |5

Edit Record | g <EiEle| NBXT) Cancel Cancel |

FARTS DATA RECORD

||4| ‘4I‘H||— o [
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The next panel specifies the source of the collected data. Select the appropriate button and press “Next”.

# Inventory Reconciliation Wizard x|

—Select Data Source

Select the zource for the inventory data you want to reconcile.

{~ Contact Memary Buttons using the ButtonLaser

{~ Contact Memary Buttons wsing the ButtonLink,

" Existing data file: |CRE MY Brawse,.. |

{7 Use the data from the previous reconciliation

< Back | Mext » | Cancel

The wizard can automatically add new records to the database. If this is desired, then Check the box and press
the “Next” button.

i - inventory.mdb = O] x|
File Edit “iew Toolz Help

—Inventary Record

# Inventory Reconciliation Wizard E
—Feconciliation
Fart Na: [551 B
™ Automatically add new items to the inventary record
Setial Mo: [0 = Anternatically delete migsing teme fremth e menisn recard
WWJC |5 B

Edit Fecord_| ¢ Bock | Moy ] comcol | | concel |

FaARTS DATA RECORD
|I4|IP‘4I‘H|

i or fo

At this point the wizard has all the information it needs to begin the reconciliation process. Press the “Finish”
button to continue.

13



i - inventory.mdb =] k3 I
File Edit “iew Toolz Help

—Inventary Record

—Finished :
Parthla: r5 “r'ou hawve completed the Inventory Reconciliation Wyizard. Press the Finish button to B I
perfarm the recanciliation, or press Cancel.
seral Mo D¢
WWJC |5 B

Edit Record | g < Back |

Cancel Cancel

FARTS DATA RECORD

||4| ‘4I‘H||— o [

The wizard will display a progress panel listing the steps required and their status. For reconciliation using a
ButtonLink, the wizard will prompt you to touch a CMB. Continue touching buttons until your inventory is
completed.

T - inventory. mdb o [=] B3 I

File Edit “iew Tool: Help

— Inwentary Record
/£ Inventory Reconciliation Wizard
— Callecting Data
o H ™ Sending Collect Inventory Command to the ButtonFReader
™ Transfering collected data from the ButtonReader
Serial Mo o1
I Importing collected data to aternporary database
WUC: B
E
@ Enzure the ButtonR eader iz in the Downloader
Edit Becord | i el st Carnce] Cancel |
Cancel |
PARTS DATA RECORD

‘H > | >

o o

After all of the data has been collected, the wizard will compare the collected data to that already stored in the
database, and it displays the results in the Inventory Reconciliation window. This window separates the data
into three areas: Matched Items, Missing Items, and Unreported Items.

14



=2 Inventory Reconciliation |
.......................................... Mizsing Items Unreported |tems ]
Matched lterns
dbid irvvid Partho Cage - Prirt |
b |0 1] E5170-11250-047 7286 —
0 1] E5170-11250-047 7H28E o
0 1] E5170-11250-047 7H28E
0 1] E5170-11250-047 7286
0 1] E5170-11250-047 7H28E
0 1] E5210-07010-042 78286
0 1] E5355-12200-047 7H28E
0 1] E5364-12102-101 7286
0 1] EBEE4-11150-043 7H28E
0 1] EBEE4-11150-043 7H28E
0 1] EEEE4-11150-043 7286
0 1] EBEE4-11150-043 7H28E
0 1] E5664-11150-043 78286
0 1] EBEE4-11150-043 7H28E
n n FRRRA-111RN-N473 FRMER LI
4 | |
] 4] Matched ltems M
Close I

1.The Matched Items tab lists those records where the collected data records match the database records. Use

the Print button to produce a hard copy report.

‘" Inwentory Reconciliation x|
Matchedltems | Missing Items: Unreported ltems ]
izzing ltems
dhid invid PartMo Cage - Print |
b |0 1] EE123-11220-043 78286 —
0 0 B5122-11300-087 | 76286 —| __Dekte |
0 1] EE123-11220-043 7H28E
0 1] EE123-11220-043 7H28E
0 1] EE123-11220-043 7H28E
0 1] EE123-11220-043 7H28E
0 1] E5126-11300-049 7H28E
0 1] E5123-11220-043 78286
0 1] E5122-11300-094 7H28E
0 1] £5123-11300-050 7H28E
0 1] E5124-11300-045 7H28E
0 1] E5124-11336-041 7H28E
0 1] E5124-11336-041 7H28E
0 1] E5124-11342-041 7H28E
n n 122101 24494 LI
" )
L] 4 Missing Items M
Cloze I

2.The Missing Items tab lists the records from the database that did not match the collected data. Use the Print
button to produce a hard copy report. Use the Delete button to remove the selected record from the
reconciliation process.

15



‘" Inwentory Reconciliation x|
Matched lterns | Missing ltems | ‘Unreported ltems '

Inreported ltems

[dbid [irvid [parti [zage Print I
Delete I

&dd

|
| A Unreparted ltems 3

=|.

=]~

Cloze I

3.The Unreported Items tab lists those collected records that did not match the database records. Use the Print
button to produce a hard copy report. Use the Add button to store the selected record in the database. Use the
Delete button to remove the selected record from the reconciliation process.

Tools/Reports
Select Reports and a Dialog block will appear as Report Selection.

'EI - inventory. mdh [_ (O] x|

File Edit “iew | Tools Help
Bead Part Id From Contact Memary

‘Wwirite Part |d To Contact Memary
Iventary Reconciliation ‘wWizard...

Reparts. .. PAR TB' DA Tﬂ
: ButtonR eader Utilities 3 |
Part M [Eo 13007 302039 Cage: I?gggg

Serial MNo: |D1 07-01116

WLIC: |1 LAF4R? Position Code:l-]

—Inventory Re

Edit Becord | Save Hecord | Delete Record | Add Record Copy Record YWrite ChB | Read ChB Cancel
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Select one of the following reports:
*All Inventory

i - inventory. mdb - |O] x|
File Edit “iew Tool: Help

— Inwentary Recard

PARTS DATA
Fart No: |55130-n?302-n49 Cage: |?8285

EElReport Selection

serialNo: |D1U?—EI111B Selecta Repart:

lLIC: |15AF452 ALL Inveniory | psition Code:|1

oot |

Edit Record | Save Record |De|ete Fetom T Aoomeror | ooy e 1 vvrite ChiB Fead CWMEB | Cancel

FARTS DATA RECORD

‘H Py o o

When you wish to view report you need to select the arrow on the drop down window and select the desired
report to be opened, than select OK. This will enable you to view your selected report. All reports have the
option of being printed.

|| 4]« 1at1 y i w| E|&|#|&| o = ] Tetah47  100% 47 of 47

oomasntl.rpt
03/11/2002
position

Part Numhber Cage Serial Numher Wuc code
65130-07302-049 78286 D107-01116 15AF452 1
65130-07332-042 78286 B297-00703 15AF456 1
65130-07332-042 78286 B297-00848 15AF456 1
65130-07332-042 78286 B297-01016 15AF456 1
65170-11250-046 78286 C100-01194 1547420 4
65170-11250-046 78286 C100-01198 1547420 6
65170-11250-046 78286 C100-01200 1547420 3
65170-11250-046 78286 C100-01204 15A7420 5
65170-11250-046 78286 D100-00033 15A7420 1
65170-11250-046 78286 D100-00036 15A7420 2
65170-11250-046 78286 D100-00040 15A7420 r
65261-08023-101 78286 JAN99-2612 1341340 O
65391-11604-041 78286 C436-00022 26D1171 1
65391-11614-101 78286 (C332-00617 26D117T 1
65395-07031-042 78286 B359-00211 26D1B51 1
65397-09801-102 78286 B288-00353 26D1710 1
6545-919-6650 96906 FRSTAID 21B21 1
65652-11214-101 78286 C321-00638 4534410 1
65652-11214-101 78286 Po02442 4534410 1
65662-03421-045 78286 B142-00234 14E1610 1
65662-03422-055 78286 B141-00236 14E1630 1
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Tools/ButtonReader Utilities

Clear ButtonReader
Tools/ButtonReader Utilities/Clear ButtonReader this clears the button reader records. This option is used when

the program doesn’t have to be reloaded

“E - C:\Program Files\oomasnt\SNT mdb - ol x| !
File Edit View | Toolzs Help

Fiead Pat |d From Contact Memory
‘wiite Part |d To Contact Memory

— Inventary Recar

Inventory Reconciliation Wizard... VARTS DATA
) Feports.. I — - |
P e r ButtonReader Utilities Clear ButtonReader : I
Initislize: ButtonF eader
Serial Ma: | Fiecondition ButtonFeader Battery |
Get ButtonF eader Yersion Infa
WL | Pasition Code: |
Edit Record | Save Record | Delete Hecordl Add Record | Copy Record | ‘wite CMEB | Read CME | Cancel |

. 1|l .‘Il EAF!TS DAD'I'FAF!ECDDF!D

Initialize ButtonReader
Tools/ButtonReader Utilities/Initialize ButtonReader this loads the ButtonReader program. This option allows
the ButtonReader to be cleared and loaded with the operating software for the ButtonReader to work properly.

& - C:\Program Files\oomasnt\SNT.mdb (=]}
File Edit “iew | Tools Help

Fiead Part |d Fram Contact Mernory
‘white Part |d To Contact bemary

Inventory A econciliation 'wizard... IPARTS DATA

Reports... Tk I
Part Ne: r Clear ButtonReader '

— Inwentory Recaor

ButtonR eader Utilities

Initialize ButtonF eader
Serial No: | Fecondition ButtonReader Battery
Get ButtonFeader Yersion [nfo
WLIC: | Position Code: |
Edit Record | Save Record | [relete Hecordl Add Record | Copy Record | ‘wirite ChiB | Fiead ChB | Cancel |

PARTS DATA RECORD
uv <l

| EL L

Initialize ButtonReader screens

Initialize ButtonReader x| Initialize ButtonReader x|

@ E nzure the ButtonF eader iz in the Downloader @ ButtonReader succeszztully initialized.
Cancel |
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Recondition ButtonReader Battery

Tools/ButtonReader Utilities/Recondition ButtonReader Battery, not used with the AT ButtonReader, this
option is used to fully discharge Ni-Cad batteries and to reset the memory of the Ni-Cad battery.

‘B - C:\Program Files\oomasnt\SNT.mdb - 1ol x|
File Edit “iew | Tools Help

Fead Part |d From Contact tMemon
Wiite Part |d To Contact Memaory

Inventory Reconciliation Wizard... IPARTS DATA

— Inventory Recor

_ Reportz... -
il r ButtonReader Utilities Clear ButtonReader : I
Initialize: ButtonF eader
Serial Mo | Recondition Butto der Battery
Get ButtonReader Yersion nfo
WLIC: | Position Code: I
Edit Record | Save Record | Delete Record | Add Record | Copy Record | “write ChE | Fead CME | Cancel |

FARTS DATA RECORD
E TS

o | O Jo

Get ButtonReader Version Info

Tools/ButtonReader Utilities/Get ButtonReader Version Info, This option allows the program to download in-
depth about Information from the reader for on-screen analysis.

H - C:\Program Files\oomasnt\SNT_mdb =181 ]
File Edit “iew | Tools Help

Fead Part |d From Contact Memory
Wwiite Part Id To Contact Memaory

|nventomy Recanciliation 'wizard... |PARTS DATA

Reparts..

ButtonReader Utilities Clear ButtonReader
Initizhze ButtonR eader

— Inventory Recor

Part Mo: r

Serial Mo | Recondition ButtonReader B attery
Get ButtonFeader
LI | Pogition Code: I
Edit Recard | Save Record | Delete Hecordl Add Recard | Copy Recard | Wit ChB | Fead CME | Cancel |

PARTS DATA RECORD

o OF o
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